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Abstract 

           Stress in the working environment has emerged as a critical factor affecting employee 
productivity, mental well-being, and organisational efficiency. Early identification of stress can enable 
timely intervention and reduce its adverse effects. This paper presents a machine-learning-based 
approach to identifying stress levels among employees using behavioural and physiological parameters, 
such as working hours, sleep duration, and heart rate. The collected dataset is preprocessed through 
normalisation and feature selection techniques to improve model performance. Several supervised 
machine learning algorithms, including Decision Tree, Random Forest, AdaBoost, and Gradient 
Boosting, are implemented and evaluated. The models are assessed using accuracy, precision, recall, 
and F1-score metrics. Experimental results indicate that the Random Forest classifier achieves superior 
performance compared to other models. The proposed system provides an efficient, cost-effective 
solution for stress detection and can be integrated into workplace monitoring systems to support 
employee well-being and organisational decision-making. 

Keywords: Stress Detection, Machine Learning, Workplace Monitoring, Random Forest, 
Classification, Employee Well-being. 

                                                 I.INTRODUCTION 

          Employee stress has become a critical concern across industries as organisations continue to 
operate in fast-paced and highly demanding environments. Growing workloads, constant deadlines, 
extended screen time, and performance-driven cultures place considerable pressure on employees. If 
such pressure persists, it can gradually result in physical exhaustion, emotional instability, weakened 
concentration, and long-term health complications. From an organisational perspective, elevated stress 
levels are associated with reduced efficiency, increased absenteeism, and declining quality of output. 
For these reasons, the ability to recognize stress at an early stage is essential for building sustainable 
and productive workplaces. 

 

         Traditional stress evaluation is generally carried out using surveys, interviews, and scheduled 
psychological screenings. While these techniques are commonly practised, they depend largely on 
personal responses and subjective judgment. Employees may not always disclose their true mental state, 
which can lead to inaccurate conclusions. Additionally, these approaches demand significant human 
effort and do not support continuous observation. The increasing availability of digital data and 
intelligent computing techniques has created opportunities to shift toward automated systems that 
provide objective stress assessment. 

 

         Modern machine learning techniques enable computers to analyse large volumes of data and 
identify patterns that are difficult to detect manually. These techniques are now widely used in health 
monitoring, behavioural analytics, and mental state evaluation. By examining quantifiable attributes 
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such as heart rate, sleeping patterns, and working duration, machine learning models can learn 
meaningful representations related to stress and generate precise predictions. 

 

         In this work, an intelligent stress identification framework is developed using supervised machine 
learning algorithms. Decision Tree, Random Forest, AdaBoost, and Gradient Boosting classifiers are 
employed to categorise stress levels based on selected physiological and behavioural features. The 
performance of the models is measured using standard metrics, including accuracy, precision, recall, 
and F1-score. The proposed system aims to provide a reliable and economical solution that enables 
early stress detection and supports organisations in enhancing employee well-being.   

                                                     II.METHODOLOGY 

This section describes the design and implementation of the proposed stress detection framework. The 
system integrates numerical data analysis with facial image processing to improve prediction reliability. 
By combining traditional machine learning algorithms with deep learning techniques, the framework 
captures both behavioural indicators and visual emotional cues related to stress. 

3.1 Overall Architecture 

The proposed framework is composed of two independent analytical pipelines: 

1. Behavioural and Physiological Data Analysis Module 

2. Visual Emotion Analysis Module 

Each module processes its respective input data separately and generates an intermediate stress 
prediction. These outputs are then integrated to produce a final stress classification result. 

Processing Flow: 

Behavioural Data → Machine Learning Classification Facial Image → Image Processing →CNN 
Classification Combined Decision Layer → Final Stress Category 

3.2 Data Acquisition 

The framework utilises two categories of input data: 

A) Behavioural and Physiological Dataset 

Structured data consisting of measurable attributes such as daily working duration, sleep patterns, and 
heart rate values is collected. These features are either obtained from available datasets or generated to 
simulate realistic workplace conditions. Each instance is assigned a stress label representing low, 
medium, or high stress. 

B) Facial Image Dataset 

Image samples representing different emotional states are obtained from open-source facial expression 
datasets or captured using a camera interface. These images serve as visual indicators of stress-related 
expressions. 

3.3 Data Preparation 

To enhance data quality and model efficiency, preprocessing operations are applied separately to 
numerical and image data. 
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Numerical Data Processing 

 Handling incomplete or inconsistent records 

 Scaling feature values for uniformity 

 Converting categorical labels into numerical format 

Image Data Processing 

 Detecting facial regions within input images 

 Extracting and aligning face segments 

 Resizing images to a standard resolution 

 Converting images to grayscale (if required) 

 Reducing noise for improved clarity 

These steps ensure consistency and optimise the learning process. 

3.4 Feature Engineering 

For structured data, relevant variables are identified through statistical analysis techniques such as 
correlation measurement to determine their influence on stress levels. 

For image data, significant facial regions, including the eyes, eyebrows, and mouth, are analysed using 
landmark detection techniques. These extracted features help in identifying visual patterns associated 
with stress. 

3.5 Model Development 

A) Supervised Machine Learning Models 

Multiple classification algorithms are implemented for structured data analysis, including: 

 Decision Tree 

 Random Forest 

 AdaBoost 

 Gradient Boosting 

These models learn relationships between behavioural features and stress categories. 

B) Deep Learning Model 

A Convolutional Neural Network (CNN) architecture is employed to process facial images. The CNN 
automatically extracts spatial features and classifies emotional patterns corresponding to stress levels. 

3.6 Data Partitioning 

Both structured and image datasets are divided into training and testing subsets using an 80%–20% 
split. The training portion is used for model learning, while the testing portion evaluates generalisation 
capability. 

3.7 Performance Assessment 

Model effectiveness is measured using established classification metrics, including: 

Journal of Engineering and Technology Management 79 (2026)

Page No: 701



 Accuracy 

 Precision 

 Recall 

 F1-Score 

These metrics provide insight into prediction quality and model robustness. 

3.8 Decision Integration Strategy 

To enhance reliability, the predictions generated by the machine learning and CNN models are 
combined through a decision fusion mechanism such as majority voting or weighted averaging. This 
integration improves overall classification stability. 

3.9 Final Stress Classification 

The integrated model outputs one of three predefined categories: Low, Medium, or High stress. The 
system is designed to support early identification of stress patterns and facilitate proactive intervention 
in workplace environments. 

 
                                   Fig.2.1 Stress Identification Architecture 

III. BACKGROUND AND RELATED WORK 

            Workplace stress has attracted significant attention from researchers due to its increasing impact 
on employee health, productivity, and organisational performance. Various techniques have been 
proposed to detect and analyse stress using physiological signals, behavioural data, and psychological 
assessments. Early studies primarily relied on questionnaire-based surveys and interviews to measure 
stress levels. Although these methods are simple to implement, they are subjective in nature and may 
not always provide accurate or real-time information. 

          With the advancement of machine learning, several researchers have explored automated stress 
detection systems using physiological parameters such as heart rate, skin conductance, 
electroencephalogram (EEG), and sleep patterns. Machine learning algorithms such as Support Vector 
Machines (SVM), Artificial Neural Networks (ANN), and Decision Trees have been widely used for 
stress classification. These approaches demonstrate promising results; however, many of them require 
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specialised sensors and complex data acquisition processes, which increase system cost and deployment 
complexity. 

           In recent years, ensemble learning techniques such as Random Forest, AdaBoost, and Gradient 
Boosting have gained popularity due to their improved accuracy and robustness. These methods 
combine multiple weak classifiers to enhance overall prediction performance and reduce overfitting. 
Several studies have reported that ensemble models outperform single classifiers in stress and emotion 
recognition tasks. 

          Apart from physiological and behavioural data, facial expression analysis has also emerged as an 
effective technique for recognising emotional and mental states. Image processing and deep learning-
based methods, particularly Convolutional Neural Networks (CNNs), have shown excellent 
performance in facial emotion recognition. CNN-based models automatically learn spatial features from 
images and are capable of capturing subtle facial patterns associated with stress. 

          Although existing studies have explored stress detection using either numerical data or facial 
images, limited research has focused on integrating both approaches into a unified framework. Most 
current systems concentrate on a single data modality, which may reduce reliability under real-world 
conditions. To address this limitation, the proposed work introduces a hybrid stress identification system 
that combines machine learning models for numerical data with CNN-based facial expression analysis. 
This integrated approach aims to improve prediction accuracy and provide a more reliable and 
comprehensive stress detection solution for working environments. 

IV. RESULTS AND DISCUSSION 

      To verify the effectiveness of the proposed stress detection framework, a series of controlled 
experiments was conducted. The implementation was carried out using Python. Classification 
algorithms were developed using the Scikit-learn library, and the deep learning component was 
implemented using TensorFlow. The system was tested under standard computational settings. 

 

6.1 Evaluation Strategy 

Model behaviour was examined using quantitative performance indicators commonly applied in 
classification tasks: 

 Accuracy, representing the overall proportion of correctly predicted samples. 

 Precision, indicating the reliability of predicted stress cases. 

 Recall, measuring the model’s ability to capture actual stress instances. 

 F1-score, providing a balanced assessment by combining precision and recall. 

These measures allow a structured comparison of different models. 

6.2 Analysis of Numerical Data Models 

Four supervised algorithms were trained using structured behavioural and physiological features: 
Decision Tree, Random Forest, AdaBoost, and Gradient Boosting. Their predictive performance on 
unseen test data is presented below. 

Table I 
Accuracy of Supervised Learning Algorithms 
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Classifier Accuracy (%) 

Decision Tree 82.4 

Random Forest 91.3 

AdaBoost 88.1 

Gradient Boosting 89.2 

The ensemble-based Random Forest model produced the highest accuracy among the evaluated 
classifiers. Its performance advantage is linked to the aggregation of multiple decision trees, which 
enhances prediction stability. 

6.3 Evaluation of Visual Stress Detection Model 

The facial image dataset was processed using a Convolutional Neural Network designed to learn spatial 
representations of stress-related expressions. After training, the CNN achieved a testing accuracy 
of 90.1%, indicating that visual cues contribute meaningful information for stress classification. 

6.4 Combined Model Performance 

To improve decision reliability, outputs from the best-performing numerical classifier and the CNN 
were integrated using a voting-based mechanism. The combined approach resulted in an overall 
prediction accuracy of 94.6%, outperforming the individual components. 

Table II 
Comparison of Standalone and Combined Models 

Model Configuration Accuracy (%) 

Random Forest 91.3 

CNN 90.1 

Combined Framework 94.6 

The observed improvement confirms that integrating heterogeneous data sources strengthens 
classification performance. 
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6.5 Key Findings 

The experimental results indicate that ensemble methods are highly effective for structured stress-
related data. The CNN model successfully extracts facial expression features associated with stress 
states. Most importantly, merging numerical and visual insights leads to improved predictive capability. 

The proposed framework provides an automated mechanism for stress identification that can operate 
without manual survey procedures. However, performance is dependent on the representativeness and 
scale of the dataset. Expanding data diversity may further enhance generalisation. 

  

Fig.4.1. ROC curves and AUC comparison of CNN, SVM, and Random Forest models for stress 

prediction. 

 

 

              Fig. 4.2. Accuracy comparison of CNN and SVM classifiers for stress prediction. 
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              Fig. 4.3. Training and validation accuracy of the CNN model over different epochs. 

 

                 V. COMPARISON TO TRADITIONAL METHODS 

                 Traditional stress assessment approaches rely on self-reported questionnaires, interviews, 
and periodic psychological evaluations to identify an individual’s mental state. While these methods 
provide basic insights into stress conditions, they often suffer from subjectivity, delayed feedback, and 
limited scalability. Moreover, they are not suitable for continuous monitoring in dynamic working 
environments. In contrast, the proposed machine learning–based stress identification framework 
integrates automated data analysis and intelligent classification techniques, offering significant 
improvements across multiple dimensions. 

 

Improved Prediction Accuracy 

         Conventional stress assessment methods depend heavily on human perception and self-reporting, 
which may not always reflect actual stress levels. Additionally, these approaches are unable to capture 
complex relationships among physiological and behavioural factors. The proposed system employs 
supervised machine learning algorithms and deep learning models to learn patterns directly from 
numerical and facial image data. By analysing features such as working hours, sleep duration, heart 
rate, and facial expressions, the system accurately identifies stress levels. This data-driven approach 
enhances classification accuracy and enables reliable detection of varying stress conditions. 

 

Real-Time and Continuous Monitoring 

         Traditional techniques are typically conducted at fixed intervals, making it difficult to identify 
sudden changes in stress levels. As a result, early warning signs may go unnoticed. The proposed 
framework supports continuous data acquisition and automated analysis, enabling real-time stress 
monitoring. This allows early detection of rising stress levels and facilitates timely intervention. 
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Reduced Human Dependency 

         Manual assessment methods require expert involvement and individual participation, which 
increases operational cost and time. The proposed system minimises human dependency by automating 
the stress identification process using machine learning models. Once trained, the system can 
independently analyse incoming data and generate predictions without manual supervision. 

 

Efficient Resource Utilisation 

           Traditional stress evaluation methods require repeated surveys, expert analysis, and manual 
interpretation, leading to higher resource consumption. The proposed framework processes data 
automatically and filters relevant features, reducing computational and human resource overhead. This 
makes the system efficient and scalable for large organisational environments. 

 

Enhanced Workplace Decision Support 

          The proposed system provides quantitative outputs such as predicted stress levels and 
performance metrics, which can be used by organisations to design wellness programs and preventive 
strategies. This supports data-driven decision-making for improving employee well-being and 
productivity. 

VI. CONCLUSION 

           This paper presented a machine learning–based stress identification system for working 
environments that aims to provide an automated, reliable, and efficient solution for detecting stress 
levels among employees. The proposed framework utilises physiological and behavioural parameters 
such as working hours, sleep duration, and heart rate, along with facial expression features extracted 
using image processing techniques. Multiple machine learning algorithms and a deep learning CNN 
model were implemented and evaluated to analyse their effectiveness in stress classification. 

          Experimental results demonstrate that ensemble-based machine learning models, particularly 
Random Forest, outperform individual classifiers for numerical data. Furthermore, the integration of 
CNN-based facial expression analysis significantly enhances prediction accuracy. The hybrid approach 
achieves superior performance compared to standalone models, confirming the effectiveness of 
combining multimodal features for stress detection. 

         The proposed system offers several advantages, including real-time monitoring capability, 
reduced human dependency, and improved prediction accuracy. By enabling early identification of 
stress, the system can assist organisations in implementing timely interventions and preventive 
strategies to improve employee well-being and workplace productivity. Overall, the proposed 
framework provides a scalable and cost-effective solution for intelligent stress monitoring in modern 
working environments. 
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